
Experiment NP-2: Skeletal Muscle Reflexes

Background

Studying the vertebrate stretch reflex is a good way to introduce students to the topics of stretch 
receptors, nerve conduction velocity, electromyograms (EMG), and motor control. Specialized 
receptors in the muscle respond to the stretching of the tendon attached to the muscle, and then send 
signals to motor neurons through a single synapse. The muscle fibers depolarize and twitch (contract) 
in response to the incoming impulse from the motor neuron. 

The Stretch Receptor

Skeletal muscles have specialized receptors which convey information about muscle length, tension, 
and pressure to the central nervous system. The sensory receptors responsible for providing information
about the length, or the rate of change of the length, of a muscle are called muscle spindles. Arranged in
parallel with muscle fibers (Figure NP-2-B1), the spindles are stretched when the muscle is stretched 
by an external force. Therefore, these receptors play a significant role in developing antigravity reflexes
and maintaining muscle tone. Muscle spindles contain a small bundle of intrafusal fibers which do not 
contribute to the overall tension of the muscle, but regulate the excitability of the sensory afferent 
spindle nerves by mechanically deforming the receptors. These fibers are innervated by gamma motor 
neurons. The majority of a muscle consists of extrafusal fibers, which are innervated by alpha motor 
neurons and are responsible for developing muscle tension. 

Figure NP-2-B1: A monosynaptic stretch reflex arc.

The Stretch Reflex 

When a muscle is stretched, excitation of its muscle spindles causes a reflex contraction of the muscle. 
This reflex response is known as a stretch (myotatic) reflex. The minimal delay between the muscle 
stretching and the reflex contraction is due to its monosynaptic pathway. The sensory afferent nerves 
from the spindles synapse directly with motor neurons; there are no interneurons. This pathway 
constitutes the shortest possible reflex arc (Figure NP-2-B1).
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Figure NP-2-B2: The major extensors and flexors of the human knee and ankle joints. The stretch 
reflexes used in this exercise are elicited by striking the patellar tendon or the Achilles tendon.

As an example of the stretch reflex, consider the reflex response that occurs when a person jumps from 
a low stool to the floor. The extensor muscles of the legs (Figure NP-2-B2) are stretched on landing, 
lengthening all their muscle spindles. The discharge of the muscle spindles is conveyed to the central 
nervous system through the fast-conducting Aα afferent axons. These sensory axons enter the spinal 
cord through the dorsal root and synapse with the motor neurons of the same extensor muscle. In turn, 
the motor neurons trigger the contraction of the extensor muscle to oppose the stretch produced by 
landing, completing the reflex arc. This reflex is one of the main reasons you keep your balance and do 
not fall down when changing certain body positions.

Students will record electromyograms (EMGs), the summation of asynchronous electrical activity 
(muscle action potentials) in the multiple fibers in the muscle, and use them to determine the time 
between the stretch of the tendon and the arrival of the motor impulse at the muscle.

Two reflexes in a human subject will be studied: the Achilles tendon reflex, and the patellar tendon 
(knee-jerk) reflex. Conduction times and nerve velocities for each reflex arc will be determined and 
compared. The effect of pre-existing tension in the effector muscle, or motor activity in other muscle 
groups, upon reflex responses will be measured. The coordination of motor activity in antagonistic 
muscles will also be studied.
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Equipment Required

PC or Macintosh computer

IX-ELVIS

USB cable

Power supply

Red, black, and green EMG leads

Alcohol swabs

Disposable EMG electrodes

PTN-104 pulse plethysmograph and reflex hammer

IX-ELVIS Setup

1. Place the IX-ELVIS unit on the bench, close to the computer. 

2. Connect the IX-ELVIS to the computer with the supplied USB cable. 

3. Insert the power plug into the rear of the IX-ELVIS and plug the transformer into the electrical 
outlet. Turn on the power switches on the rear and on the upper right side of the top of the unit 
and confirm that the LEDs are illuminated.

Start the Software

1. Start the Software

2. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 
not available, click on the Windows Start menu, move the cursor to All Programs and then to 
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 
will appear as the program opens.

3. On the Main window, pull down the Settings menu and select Load Group.

4. Locate the folder that contains the settings group, ELVISNI.iwxgrp. Select this group and click 
Open.

5. Pull down the Settings menu again. Select the SkeletalMuscleReflexes-LS2 settings file.

6. After a short time, LabScribe will appear on the computer screen as configured by the 
SkeletalMuscleReflexes-LS2 settings.

7. The settings used to configure the LabScribe software and the IX-ELVIS for this experiment are
programmed on the Preferences Dialog window which can be viewed by selecting Preferences 
from the Edit menu on the LabScribe Main window.

EMG Cable and Reflex Hammer Setup

1. Locate the PT-104 pulse plethysmograph (Figure NP-2-S1) and the red, black, and green EMG 
electrode lead wires (Figure NP-2-S2).
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Figure NP-2-S1: The PT-104 pulse plethysmograph.

Figure NP-2-S2:EMG lead wires connected to disposable electrodes.

2. Plug the mini-DIN connector to the PTN-104 into the Channel 3 input of the IX-ELVIS (Figure 
NP-2-S4).

3. Plug the red, black, and green EMG lead wires into their respective sockets of Channel 1 of the 
IX-ELVIS (Figure NP-2-S4).

4. Use an alcohol swab to clean and abrade three regions on the calf of the left leg for electrode 
attachment. One area is near the ankle, the second is in the middle of the calf muscle, and the 
third area is about 3 inches below the back of the knee. Let the areas dry.

5. Remove the plastic disk from a disposable electrode and apply it to one of the abraded areas. 
Repeat for the other two areas.
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Figure NP-2-S3: Circuit diagram for recording electromyograms from the calf muscles.

6. Snap the ends of the EMG lead wires onto the disposable electrodes (Figure NP-2-S3), so that:

• the red (+1) lead wire is attached to the electrode near the back of the knee.

• the black (-1) lead wire is attached to the electrode in the middle of the calf muscle.

• the green (C) lead wire is attached to the electrode on the ankle that functions as the ground.

7. Attach the plethysmograph to the side of the head of the patellar hammer with its velcro strap. 
When the reflex hammer strikes the tendon, the plethysmograph will emit a signal which marks 
the recording on the Tendon Tap channel at the point in time when the tendon was struck.
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Figure NP-2-S4: The EMG lead wires and pulse transducer connected to the IX-ELVIS.

Exercise 1: Achilles Tendon Reflex

Aim: To determine conduction time from tendon tap to response of the gastrocnemius muscle in
the Achilles tendon reflex arc.

Procedure

1. Instruct the subject to sit on a lab bench so that the subject’s thighs are supported by the top of 
the bench and his or her calves hang freely. The subject could also kneel on a padded chair with 
the subject’s ankles and feet hanging over the edge of the seat.

2. The Achilles tendon is located above the heel and connects the gastrocnemius muscle to the 
tarsal bone of the foot. Tap the tendon with the wide end of the reflex hammer a few times to 
locate a point on the tendon which produces a consistent contraction of the gastrocnemius 
muscle and a downward movement of the foot (plantar flexion). The opposite, upward 
movement is known as dorsiflexion.

3. Click Record and then instruct the subject to move his or her foot up and down to demonstrate 
the type of EMG that occurs during plantar flexion and dorsiflexion. Click AutoScale on the 
EMG Calf channel. 

4. Type “<Subject’s Name> Achilles Tendon Reflex” in the Mark box that is to the right of the 
Mark button. Press the Enter key on the keyboard to mark the recording. Continue recording.

5. Instruct the subject that the exercise has begun and that his or her tendon could be tapped at any
time. 
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6. Tap the subject’s Achilles tendon to elicit the stretch reflex. Record a total of ten trials using the 
same tapping force. 

7. After the tenth trial, click Stop to halt recording.

8. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file. Designate the file type as *.iwxdata. Click on the Save button to save 
the data file. 

9. Repeat this exercise on the same subject using different amounts of force.

Data Analysis

1. Scroll to the beginning of the data recorded for Exercise 1 to display the first trial on the Main 
window.

2. Use the Display Time icons to adjust the Display Time of the Main window to show both the 
signal made by tapping the tendon and the EMG response on the Main window. This trial can 
also be selected by:

• Placing one cursor before the beginning of the signal from the tendon tap and the second 
cursor after the subject’s EMG response; and

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the complete
reaction trial to the width of the Main window (Figure NP-2-L1).

Figure NP-2-L1: An Achilles tendon reflex response and patellar hammer signal displayed on the Main
window. The cursors are in position to measure the reflex conduction time
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3. Click on the Analysis window icon in the toolbar (Figure NP-2-L2) or select Analysis from the 
Windows menu to transfer the data displayed in the Main window to the Analysis window 
(Figure NP-2-L3).

Figure NP-2-L2: The LabScribe toolbar.

4. Look at the Function Table that is above the display of the EMG Calf channel displayed in the 
Analysis window. The mathematical function, T2-T1, should appear in this table. The value for 
T2-T1 is seen in the table across the top margin of the EMG Calf channel.

5. Use the mouse to click on and drag a cursor to the onset of the signal recorded from 
plethysmograph on the reflex hammer which is displayed on the Tendon Tap channel. Drag the 
other cursor to the beginning of the EMG wave which is recorded on the EMG Calf channel.

6. Once the cursors are placed in the correct positions for determining the reflex conduction time, 
record the value for T2-T1 in the Journal. The value can be recorded in the on-line notebook of 
LabScribe by typing its name and value directly into the Journal. Values can also be recorded in 
separate data table.
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Figure NP-2-L3: An Achilles tendon reflex response and patellar hammer signal displayed on the 
Analysis window. The cursors are in position to measure the reflex conduction time.

7. The functions in the channel pull-down menus of the Analysis window can also be used to enter
the name and value for T2-T1 into the Journal. To use these functions:

• Place the cursors at the locations used to measure the reaction time.

• Transfer the name of the T2-T1 function to the Journal using the Add Title to Journal 
function in the Reaction Time Channel pull-down menu.

• Transfer the value for T2-T1 to the Journal using the Add Ch. Data to Journal function in the
Reaction Time Channel pull-down menu.

8. Once the reflex conduction time in the first trial is measured and recorded, use the scroll bar at 
the bottom of the Analysis window to move the data from the second trial onto the window. If 
needed, use the Display Time icons to adjust the width of the Analysis window to show both the
signal from the tendon tap and the subject’s EMG response on the same window.

9. Repeat Steps 5 through 7 on the data from the second trial.

10. Use the same techniques used in Steps 5 through 8 to measure the reflex conduction times from 
the other eight trials.

11. Once the reaction times in all ten trials have been measured and recorded, open the Journal and 
use the values to determine the mean reflex conduction time of the subject. Discard the longest 
and shortest times from the data set, and determine the average of the eight remaining reaction 
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times. Record the mean reflex conduction time for the Achilles reflex at this relative strength of 
tap in Table NP-2-L1.

12. Measure the distance between the belly of the subject's calf muscle and the site of the sensory-
motor synapse in the spinal cord. For the purpose of this exercise, assume that the sensory-
motor synapse is at spinal segments L5 and S1, which are just above the top of the hip bone. 
Multiply this measurement by 2 to determine the total length of the nerve path.

13. Even though this stretch reflex is known as a monosynaptic reflex, the pathway includes the 
neuromuscular synapse (NMJ) as well. Assume that synaptic transmission takes about 0.5 msec,
calculate the conduction velocity in the nerves composing this reflex pathway by the equation:

14. Record the conduction velocities for the Achilles reflex recorded from the three different 
tapping strengths in Table NP-2-L1.

Questions

1. Which muscle groups are involved in plantar flexion and in dorsiflexion of the ankle?

2. Does the subject’s reflex time change with different stimulus strengths? Why does it or doesn’t 
it change?

3. Design an experiment to measure the reflex time more precisely?

Exercise 2: Patellar Tendon (Knee Jerk) Reflex

Aim: To determine conduction time from tendon tap to response of the quadriceps muscle in the
patellar tendon reflex arc.

Procedure

1. Instruct the subject to sit on a lab bench so that the subject’s thighs are supported by the top of 
the bench and his or her calves hang freely. 

2. Remove the lead wires of the EMG recording cable from the electrodes over the subject’s calf 
muscle. Keep these electrodes on the subject’s calf muscle.

3. Place a new set of recording electrodes on the quadriceps muscle of the subject on the medial 
side of the thigh (Figure NP-2-L4), so that:

• the black (-1) lead wire is attached to an electrode which is about 12cm from the knee.

• the red (+1) lead wire is attached to an electrode which is about 10cm above the negative 
electrode.

• the green (C) lead wire is attached to the electrode on the knee that functions as the ground.
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4. Feel the position of the patellar tendon just below the kneecap. Place one hand on the patella 
(kneecap), and use the other hand to tap the patellar tendon with the reflex hammer. Find the 
point on the patellar tendon that causes the greatest response from the quadriceps muscle.

5. Click Record and then instruct the subject to raise and lower his or her lower leg to demonstrate
the type of EMG that occurs during quadriceps contraction and relaxation. Click AutoScale on 
the EMG Quad channel. Click Stop to halt the recording.

Figure NP-2-L5: Circuit diagram for recording EMGs from the thigh muscles.

6. Type “Patellar Tendon Reflex” in the Mark box that is to the right of the Mark button. 

7. Click Record. Press the Enter key on the keyboard to mark the recording.

8. Instruct the subject to relax his or her quadriceps muscle and that the exercise has begun. 

9. Tap the subject’s patellar tendon to elicit the stretch reflex. Record a total of ten trials using the 
same tapping force. 

10. After the tenth trial, click Stop to halt recording.

11. Select Save in the File menu.

12. Repeat this exercise on the same subject while the subject is voluntarily contracting his or her 
quadriceps.

13. Repeat this exercise on the same subject while the subject is performing Jendrassik’s Maneuver.
To perform this muscle activity:

• The subject should curl the fingers of each hand toward its palm form a cup-shaped grip.

• The subject should hold his or her hands and arms in front of his or her chest so that elbows 
are pointed out.

NervePhysiology-SkeletalMuscleReflexes NP-2-11



• The subject should interlock his or her hands using the cup-shaped grip.

• While the subject’s patellar tendon reflex is recorded, the subject attempts to pull his or her 
hands apart. Jendrassik’s Maneuver is an isometric contraction, in which motor activity that 
may affect reflex responses, occurs in another part of the body (the arm and shoulder 
muscles).

Data Analysis

1. Use the same technique explained in Exercise 1 to measure and record the conductions times of 
the subject’s patellar reflex, patellar reflex with quadriceps muscle tension, and patellar reflex 
with Jendrassik’s Maneuver.

2. Enter the mean reflex conduction times and velocities for this exercise in Table NP-2-L1.

Questions

1. Compare the average reflex times of the Achilles and patellar tendon reflexes. What factors 
contribute to the difference between the two reflex times?

2. Is the patellar reflex inhibited or enhanced by voluntary muscle activity in the quadriceps? 
Speculate on the mechanism of inhibition or enhancement.

3. Is the patellar reflex retarded or facilitated during the Jendrassik's Maneuver (voluntary muscle 
activity an another part of the body)? Speculate on the mechanism of retardation or facilitation.

4. Besides excitatory inputs from stretch receptors, what synaptic inputs might influence the 
activity of spinal motorneurons?

Table NP-2-L1: Reflex Conduction Times and Velocities for Achilles and Patellar Tendon
Reflexes.

Reflex
Mean Reflex Conduction Time
(ms)

Reflex Conduction Velocity 
(m/s)

Achilles Tendon - Light Tap

Achilles Tendon - Medium Tap

Achilles Tendon - Heavy Tap

Patellar Tendon - Quads Relaxed

Patellar Tendon - Quads Tensed

Patellar Tendon - Jendrassik’s 
Maneuver
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